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Abstract: This document explains the basics of the Microsoft Windows 
operating system. It is intended for users who are either new to 
personal computing, or are new to the Windows environment.  
Although this document is written specifically for Windows XP, 
there are a lot of commands and features that are the same or 
slightly different for Windows 95/98/2000. 
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Introduction 
Windows is a computer operating system that provides a graphical interface between you 
and your computer’s hardware and software applications. The graphical interface 
determines what things look like on screen and in general how you work with your 
computer. 

Objectives 
This workshop provides the basics for using the Windows operating system. After 
today’s workshop, participants will be able to: 

• Identify desktop objects.  

• Select programs with the Start Menu.  

• Create shortcuts for programs, files, and folders. 

• Identify the parts and types of a window. 

• Understand the difference between memory and storage. 

• Perform “housekeeping” procedures to find, copy, move, and delete files, folders, 
and programs. 

• Use the Search and Help features.  

• Shut down Windows properly. 

Prerequisites 
There are no prerequisites for this class. 

Related Training Available from ACS 
All ACS workshops are free to KU students, staff, faculty, and approved affiliates. The 
general public is also welcome to most workshops, but some ACS workshops require a 
registration fee for them. 

To learn more about or register for workshops, receive automatic announcements of 
upcoming workshops, and track workshops you’ve registered for and have attended, visit 
the ACS Web site at www.ku.edu/acs/train. You can also check our online schedule at 
www.ku.edu/acs/schedule for a list of class offerings and their availability. For further 
workshop related questions, please email training@ku.edu. 
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Definitions 
Term Definition 

Windows An operating system designed by Microsoft with a graphical user interface 
(GUI). 

The interface provides a graphical means of working with your computer 
via a "point and click" interface with the use of a mouse.  Previously, all 
interactions with the computer were accomplished via commands that 
were typed using the keyboard. 

Memory vs. Storage 
Term Definition 

Memory Also known as RAM or Random Access Memory. Your computer uses 
RAM to temporarily store parts of the operating system, open applications, 
and any files that you're currently working on. The computer can access 
data in RAM much faster than data on your hard disk. Having too little 
RAM can slow down your computer or prevent you from opening 
applications or completing tasks.  Any file that you are working on in RAM 
is volatile (i.e. it will be lost if your computer loses power).  To prevent this 
from happening, you should move your files into some type of storage.  
Think of the RAM as your high-tech desktop or workspace. 

Storage Unlike memory, storage is a permanent place for keeping your data (i.e. it 
will not be lost if your computer loses power).  There are several types of 
storage available to computers including; the computer’s hard disk, floppy 
disks, zip disks, and network drives.  To move a file that you are working 
on from memory into storage, you will need to save it.  To save a file you 
must give the file a name and indicate where you would like to store it.  
You can identify each drive by its assigned letter.  Usually, you can 
choose C:\ (for the hard disk), A:\ (floppy disk), or U :\ (typically a network 
drive) depending on what is available to you. Additional drives may be 
labeled with the letters D:\ (for the CD-Rom drive) or E:\ (Zip drive or CD-
Recordable).  Anytime you make further changes to a file that has been 
saved, you need to save it again.  You should save files that you are 
working on frequently so that you do not lose data and time if something 
should cause you to lose power to your computer.   Think of your storage 
devices as your high-tech file cabinets, where things can be stored and 
later retrieved.   

Many other terms are defined in context throughout the remainder of this document. 
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An Orientation to the Desktop 

Desktop 
The desktop is the overall view of your computer and work area; the desktop covers the 
entire screen and is somewhat analogous to the top of a conventional desk.  Items on your 
desktop can be moved, thrown away, or placed in folders to work with later.  The desktop 
can be arranged to contain the items that you use most frequently.  For example, if you 
work on a weekly report, that document can be accessed easily if you place it directly on 
your desktop. 

There are many ways that you can organize and personalize your Windows desktop.  For 
instance, you can change the desktop pattern or picture (see Appearance and Themes, 
page 21) and create shortcuts to files, folders, server volumes, and applications (see 
Creating Shortcuts, page 9). 

Icons 
Icons are symbols or pictures that represent items stored on your computer.  Examples of 
items icons represent include folders (directories or groups), documents, programs, and 
even computer hardware. 

Folder icons 
Folder icons are used to keep related documents or applications together.  Often you have 
folders within folders. 

 
Two folder icons 

Application icons 
Application (a.k.a. program) icons represent the executable programs (software) available 
on your computer.  For example: Word, PowerPoint, Photoshop, Excel, and 
Dreamweaver. 

 
Two application icons 
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Document icons 
Document icons represent the files that you create using software.  Generally, document 
icons resemble the program icon that created the file.  For example, a Word document has 
part of the same logo as the Word application in which it was created. 

 
Two document icons 

Original icons 
The icons that typically display when you first access your Windows desktop are My 
Computer, My Network Places, the Recycle Bin, and Internet Explorer. 

Taskbar 
The Taskbar, located at the bottom of your screen, contains the Start button.  When you 
open a program, document or any other window, a button appears on the Taskbar. 

Start button 
This button is used to open the start menu, which provides you with access to 
applications or documents, Help and Support, the Search feature, and the Control Panel 
settings.  Additional information about the Start button is detailed below. 

Clock 
A clock displays on the right end of your Taskbar.  If you simply hold your mouse 
pointer over the clock, the current date displays.   

Start menu 
The start menu allows you to access folders, files, or programs quickly through the 
display of a menu and submenus.  It is organized into submenus with recently used 
programs, commonly accessed folders (such as My Documents, or My Computer) and all 
available programs (the All Programs menu). 

1. To access an item on the start menu, click the Start button located on the Taskbar. 

2. Continue to point on folders until the file or program you want to access displays or 
is highlighted. 

3. Click the program or file name. 
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Organizing the desktop 

Adding items to the Program Menu 
There are many ways that you can organize and personalize your Windows desktop.  You 
can change the look of your desktop, create shortcuts to files, folders, networks, and 
programs; you can determine which programs start when you turn on your computer; and 
you can change the list of items in the Start menu. 

Any file or shortcut that is placed in a special folder displays within the first level of the 
Programs list under Start menu.  To place an item on the Programs list: 

1. Double-click My Computer. 

2. Double-click the C: drive icon. 

3. Double-click the Documents and Settings folder (directory). 

4. Double-click the All Users folder (directory). 

5. Double-click the Start Menu folder. 

6. Double-click the Programs folder. 

7. Move or copy any folder or file to the Programs folder or create a shortcut (see 
below) to any folder or file to have the item appear in the All Programs list on the 
Start menu. 

Creating shortcuts 
A shortcut is an icon that points to a program, folder, or document’s original icon.  
Double-clicking the shortcut has the same effect as double-clicking the object’s original 
icon.  Shortcuts make it possible to place duplicate icons at several locations without 
duplicating the original program, document, folder, etc.   

A shortcut has the same icon as the original, but the icon has a small badge with an arrow 
( ) in its lower left corner. The name of the shortcut (which you can change) appears in 
italics. 

Note: When you delete a shortcut, the original is not deleted. 

1. To create a shortcut, locate an icon that represents a program, document, folder, or a 
hardware device such as a floppy drive or a network drive. 

2. Once the object is located, use your right mouse button to drag the icon to a new 
location.   

3. When you release your mouse button, a pop-up menu displays.  Select Create 
Shortcuts here. 
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Alternatively: To place a shortcut directly in the Start menu, use your right 
mouse button to click and drag the object to the Start 
button. 

Windows 
A window displays your program or document when it is open.  You can have several 
windows open on your desktop at the same time, and you can reposition and resize them.  
Windows can overlap, creating the appearance of being stacked on top of one another on 
the desktop, just like papers on a real desktop. New windows are created when disks, 
folders, programs, and documents are opened; closing a window removes it from the 
desktop.  Generally, Windows remembers the size and location of your windows when 
they are closed.  When you open the window again, it displays in the same location and 
size that it was when you last closed it.  There are three major window types: program, 
document, and folder. 

Parts of a window 
Since all windows have essentially the same parts, once you learn to work with one 
window you are able to work with all windows.  

• Program windows are those that contain an application that you are running such as 
Word, Photoshop, or Netscape Navigator. 

• Document windows open within a program window.  For example, within Microsoft 
Excel, you can have several documents open at the same time. 

• A folder window displays the contents of a folder, including program icons, 
document icons, or other folder icons. 

Title Bar 
The title bar is at the top of the window.  It displays the document, program, or folder 
name, along with the name of the application that is open (in program windows only). 
The title bar also tells you which window is “active.” The title bar of the active window 
on your desktop is highlighted; all other windows will have grayed-out title bars. 

Even though you may have more than one window open on your desktop, you can only 
work with one at a time. The one you are working with is the “active” window. You can 
make a window “active” by clicking any place on the window. 

 
The Title and Menu Bars for a document in Notepad 
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Window buttons 
The title bar also displays three small buttons on the right of the title bar, which change 
the display of the window: minimize, maximize/restore, and close buttons. 

Minimize button 
When you click the minimize button (on the left), the window disappears and is 
represented by a button on the Taskbar.  When a window is minimized, you display it 
again by clicking the window button on the Taskbar. 

Maximize button 
When you click the maximize button (in the center), the window is enlarged to take up 
the entire Desktop if it is an application or folder window.  When you maximize a 
document icon, the window takes up the entire application window. 

Restore button 
When you maximize a window, the restore button replaces the maximize button.  
Clicking the restore button displays the window in its previous size and location. 

Tip: Double-clicking the window’s taskbar will maximize or restore the 
window. 

Close button 
The close button (on the right) closes the window.  Click the close button once to 
completely close the document, application, or folder window. 

The Menu bar 
The Menu bar appears just below the Title bar and displays additional options when you 
click the menu name.  The commands and features that you access on the menu bar tell 
Windows and the Windows programs what actions to carry out. 

Note: Besides clicking on the menu name, you can also access menus by 
holding down the Alt key and the underlined letter in the menu’s 
name.  For example, in most programs the File menu can be accessed 
by holding down the Alt and F keys at the same time. 

Scroll Bars 
Use the scroll bars to move around within your a window.  Often a window will actually 
contain more than can be displayed in it at its current size, so that the window only shows 
part of its contents at any one time.  Scrolling the window’s display area moves its field 
of view to reveal other contents.  Click the scroll arrows in the scroll bars, which are 
located on the right and bottom edges of the window, to move up, down, left or right.  
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Each click moves the view through the window contents a little at a time, or you can click 
and hold to scroll continuously.  The scroll box moves through the scroll bar as you 
scroll, indicating the relative location of the view within the total contents of the window; 
you can also drag this scroll box directly to scroll to another part of the window.  Finally, 
you can click in the gray bar on either side of the scroll box to scroll by the windowful. 

Note: When a window is large enough that it displays its entire contents at 
once—no contents are beyond its borders—its scroll bars are disabled. 
The horizontal and vertical scroll bars can be enabled and disabled 
independently. 

Resizing a window 
Placing your mouse on any window border or corner may alter the window size.  When 
the pointer changes into a double-headed arrow, hold down the left mouse button, and 
drag the mouse to alter the dimensions of the window.   

Note: You cannot resize a window when it is displayed in full screen 
(maximized). 

Moving a window  
To change the window placement, place your mouse on the Title Bar and click and drag 
to reposition the window.   

Arranging all open windows 
Right-click an empty area on the taskbar and select Cascade Windows to see all the open 
windows at once.  Windows that are reduced to taskbar buttons will not be displayed. 

Right-click an empty area on the taskbar and click Undo Cascade to change it back. 

Creating a new folder 
To create a new folder, right-click the mouse in a blank area and from the pop-up menu 
select New and then choose Folder. While its name (initially “untitled folder”) is 
highlighted, type a new name for the folder and press Enter. (If you accidentally deselect 
the name before changing it, follow the instructions under Renaming files and folders, 
below.) The new folder will be created in the active window (or on the desktop if no 
window is active). 

Moving or coping a file/folder 
To move or copy files, you need to display the files or folders to be moved or copied as 
well as your destination location.  In the example below, the windows are aligned to copy 
the new.xls file from the My Documents folder to the Classes folder.  
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Copying by dragging and dropping a file from the My Documents folder to the Microsoft 

Office folder located in the Classes folder 

1. Point your mouse on the file to copy and hold down the mouse button.  

2. Drag the icon to its new location and release your mouse button when the destination 
location becomes highlighted.   

Note: The act of point-click-hold-move-release is known as "drag and drop."  
When you drag a file or folder between two drives, the default behavior 
is “copy”. If you drag a file or folder between locations on the same 
drive, the default behavior is “move”.  

You can force a “copy” by holding down the Shift key while you drag 
with the left mouse button. 

You can force a “move” by holding down the Ctrl key while you drag 
with the left mouse button. 

If you drag and drop files or desktop objects with the right mouse 
button instead of the left, you get a pop-up menu when you drop them 
on the target destination. The pop-up menu allows you options such as 
Move Here, Copy Here, and Create Shortcut Here. 

Renaming files and folders 
If you need to rename a file, folder, or any icon, you can use one of several techniques. 

1. Right-click the icon you want to rename and select Rename. 

2. The name of the icon is highlighted and a cursor is located at the end of the name.  If 
you type a new name, you are replacing the whole name.  To edit a few characters, 
use the left arrow to move the cursor through the text.  You can then use simple text 
editing techniques to make your changes. 

3. Click outside the icon name to store the new name. 

Alternative: You can slowly double-click to rename the icon.  Click the 
name and then click a second time, making sure that you wait 
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between clicks.  This action highlights the name and then 
allows you to edit or retype the filename. 

 

Note: If the previous filename extension was associated with a program, for 
example, .xls, you may get a message about changing the “extension 
of the file may make it unworkable.”  You can choose to rename the 
file like you wish, but it is recommended that you choose No to this 
message.  Rename the file again but include the extension. 

Deleting a file/folder 
A file, folder, or any object can be deleted using one of several methods. 

• Right-click the object and select Delete from the pop-up menu. 

• Drag the object to the Recycle Bin icon on the desktop. 

• In some cases, you can select the object and press the Delete key. 

Note: Any deleted file is placed in the Recycle Bin.  You must empty the 
Recycle Bin to permanently delete the file from the hard drive. 

To empty the Recycle Bin, place your mouse on the Recycle Bin icon 
and use your right mouse button to click.  Select Empty Recycle Bin 
from the pop-up menu. 

Searching for objects 
The Search command allows you to search any attached drive or location for a file, a 
folder, or, if you are attached to a network, a computer on the network.  The Search 
command can be accessed through the Start menu or in folder windows by clicking on 
the View menu, clicking on Explorer Bar, and then selecting Search. 

Once you access the Search command, the following window displays: 
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The Search Window 

To search for a file or folder:  

1. Type the filename or a substring of the filename in the name section of the search 
criteria. 

2. Identify the location to search. If the drive or directory is not listed correctly in Look 
in:, click the down arrow to get a menu of common drives and folders.  If the desired 
location is still not shown, click Browse at the bottom of the menu.  This opens a 
dialog box in which you can select any folder or drive on your computer. 

3. For a simple search, click the Search button. 

4. A list of files or folders that meet your criteria displays.  

5. If you searched for a program file (an executable), a file associated with a program, 
or a folder, you can double-click the icon to open the application and/or window. 
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The results of searching for files with the .xls extension (Excel files) 

The Search command offers several features to search for an item.  It allows you to 
search based on what type of file you are searching for.  The most general case is simply 
searching for files or folders 

Using the Start menu to find a file/folder 
1. Click the Start menu and then click Search. 

2. Select All Files and folders from the menu on the left of the window that comes up.  

3. Type the name of the file (or a part of the filename) in the name input area and click 
Search. 

Using Explore to find a file/folder 
You can also access the Search command through the Start menu when using Explore. 

1. Use your right mouse button to click the Start button once. 

2. Click Explore. A split screen displays the file/folder directory tree on the left and a 
list of sub-items on the right. 

3. In the toolbar at the top, click the Search button. 

4. Select All Files and folders from the menu on the left of the window. 
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5. Type the name of the file (or a part of the filename) in the name input area and click 
Search. 

Note: You can also access Explore by holding down the Shift key while 
double-clicking My Computer, a folder icon, a drive icon, or a 
network icon. 

Advanced Searches 
You can use the Advanced search to enter additional searching criteria. The advanced 
search is useful if you are looking for 

• a specific file type (i.e., a screen saver, an application, an Excel file, etc.). 

• a file that has a specific string of characters or text within the file. 

• a file that is within a certain size. 

Creating advanced searches 
Click on any of the three double down arrows in the Search folder window to show 
options for more advanced searches.   

 
Advanced searching options 
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Creating advanced searches based on date 
1. Click the down arrows next to “When was it modified?” to reveal options as in the above 

figure. 

2. Fill in the appropriate dates or select from the more general options. 

3. Click the down arrow next to the appropriate criterion to enter additional search criteria.   

4. When finished entering the criteria for searching, click Search to begin the search. 

Application Basics 
While most application commands and operations will naturally vary from one 
application to another according to each application’s purpose and design, there are many 
things that are done in a standard way, and are thus common to the vast majority of 
Windows applications. 

Working with document files 

Opening a document 
If you are working in an application and want to open an existing document in that 
application, click on the File menu and choose Open. You will see the Open dialog box: 

 
An Open dialog box in Microsoft Word 

This dialog box provides tools for locating and opening files. It shows a particular 
location, and the files and folders at that location. The current location is indicated by the 
pop-up menu at the top of the window. The list displays the contents of that location. 
Both of these are used to locate a file. 
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To locate an item inside a folder that appears in the list, double-click the folder; it will 
become the current location. If the desired file is in a subfolder, repeat the process until 
you’ve reached the folder that directly contains the file. 

To locate an item that resides outside of the current location, use the pop-up menu at the 
top of the window. It displays the parent folders of the current location, i.e., those that 
contain it. In other words, for a subfolder location, the item below the subfolder’s name is 
the folder that contains it. The next item down the list is the folder that contains that 
folder, and so on, until you reach the disk that contains the top-level folder, and, finally, 
the desktop. To move to any ancestor location, choose it from the pop-up menu; it then 
becomes the current location. 

With these two interface elements, you can move to any location on your system.  Often 
both will be required to navigate to a file, as you’ll need to move up out of an initial set 
of folders (using the pop-up menu) so that you can then drill down into another set of 
folders (using the list). 

Once you’ve located the desired file in the list, double-click it to open it. 

Saving a document 
To store a document you’re working on to disk, you must save it.  Until and unless you 
save a document, its contents reside only in memory, and will be lost when the 
application quits.  Saving a document stores it so that you can return to it again, even 
after the computer has been powered off.  To save a file you must give it a name and 
indicate where you would like to store it. 

1. To save a document, click on the File menu and choose Save.  The first time you 
save a document, you will see the Save As dialog box: 

 
A Save dialog box in Microsoft Word 
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This dialog box provides tools for specifying the name that the document will have 
when stored as a file on disk, and the location where it will be stored. Note the 
similarity to the Open dialog box (see Opening a document, above). 

2. Determine where you would like to place the new file, using the techniques described 
in Opening a document, above. 

3. Enter a name for the file in the Name field. 

4. Click Save.  A new file with the given name will be created in the location indicated 
by the pop-up menu at the top of the window, and the document’s contents will be 
stored in it. 

Anytime you make further changes to a file that has been saved, you will need to save it 
again.  When saving a file that has been saved before, the Save dialog box will not 
appear, since the file’s name and location have already been established.  You should 
save files that you are working on frequently so that you so do not lose data (and time) if 
something should cause you to lose power to your computer. 

Saving a document with a different name or location 
To save a document with a new name or in a different location, choose Save As from the 
File menu and specify a new name and/or location as described above.  The original file 
will be left in place, unchanged. 

Saving a document in a different file format 
Many programs let you save documents in multiple file formats.  To save a document in a 
file format other than the default for the application, choose an option from the Format 
pop-up menu when in the Save dialog box, before clicking the Save button. 

Editing text 
Whenever you’re typing or editing text, you will see a blinking line (the insertion point), 
somewhere in the text.  The insertion point shows where text will be inserted when you 
type. 

Inserting text 
1. Click to place the insertion point where you want the new text to appear. 

2. Type the new text. 

Deleting text 
1. Drag across the text you want to delete.  The text changes color to show that it’s 

selected. 

2. Press the Delete key on your keyboard. 
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Changing the size, font, or style of text 
1. To change the size, font, or style of text, drag across the text to select it. 

2. Choose the size, font, or style you want from the menus.  Only the selected text is 
affected. 

Moving and copying document content 

Copying and pasting 
You can copy text, graphics, pictures, or movies, then paste what you copied in another 
place in the same document or in a different document—even in a different application.  

1. Select the text, graphic, picture, or movie you want to copy. 

2. Choose Copy from the Edit menu, or press Ctrl+C. 

3. Select where you want to paste the item. 

4. Choose Paste from the Edit menu, or press Ctrl+V. 

To move document content rather than copy it, substitute Cut for Copy in step two 
above, or Ctrl+X for Ctrl+C. 

Drag and drop 
You can also move text, graphics, pictures, and movies by dragging.  

1. Select the text, graphic, picture, or movie. 

2. Drag it to where you want it to go. 

Undo 
In many applications, for most actions, you can undo your last action by choosing Undo 
from the Edit menu. This is very useful for correcting mistakes! 

Customizing Your Computer 
The Control Panel allows you to alter settings for or customize your computer.   There are 
a number of individual control panels for all the various types of settings that can be 
adjusted.  All changes made through the Control Panel are stored in the Windows 
configuration Registry.  Some of the Control Panel settings can be altered from other 
locations.  For example, to change your desktop display, you can access the Control 
Panel, click Appearance and Themes, then click Display and make your changes.  Or 
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you can right-click on your desktop and then select Properties from the pop-up menu.  
Both of these above actions access the same Display Properties dialog box.   

Control Panel icons 
You can explore your control panel options by investigating the control panel icons; you 
can safely view control panels without making changes.  Which control panel icons you 
have on your system depends on what hardware and software you have installed.   

There are two views available for the control panel.  Category View organizes common 
tasks into groups.  For example, changing the theme, screensaver, or background image 
can all be done by accessing the Appearance and Themes category.  The Classic View 
presents all the icons available in much the same way that Windows 95/98 had.  Below 
are descriptions of the categories found in the Category View.    

Appearance and Themes 
This category contains utilities for setting display properties such as resolution, 
background image, and screensaver (customize the way your desktop, menus, and 
windows look).  It also allows you to apply a theme to change the look of the Windows 
environment. 

Network and Internet Connections  
This category contains utilities for connecting to the Internet, a local network at your 
workplace, or a home network.    

Add or Remove Programs 
This category allows you to add or remove programs, including Windows.  You can also 
use this option to create a start-up disk in case Windows gets corrupted on your hard 
drive. 

Sound, Speech and Audio Devices 
This category has utilities for changing speaker settings, system volume, and text-to-
speech readers.   

Performance and Maintenance 
This category has utilities for getting information on, and changing system settings of, 
Windows and your computer.  Included are such things as backing up data, task 
scheduling, and administrative tools.  You can also access this dialog box by right-
clicking My Computer and selecting Properties. 
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Printers and Other Hardware 
This category contains the utilities to install new peripherals such as mice, printers, 
scanners, and faxes. 

User Accounts 
This category has utilities for creating and maintaining the accounts of people who use 
the computer.   

Date and Time plus Language and Regional Options 
These categories have utilities for setting the system time, default language, and any 
regionally varying things such as number and currency formatting.   

Accessibility Options 

Accessibility Options lets you set keyboard, mouse, sound, display and other options that 
make a Windows computer easier to use by the visually, orally, or motor impaired. 

Getting Help 
There are many ways to access help through Windows.  Almost all dialog boxes have 
Help on the menu, but there are several less obvious methods for getting help.  The Help 
feature can be accessed through the Start menu by clicking Start and then Help and 
Support.  

 

Windows Help and Support Center 
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What’s This button  
The What’s This button is found on the toolbar or in the title of some programs.  
Clicking the button changes your cursor to a large question mark.  When you click an 
item, information about that command or option displays, generally in an information 
box. 

You can frequently display the same pop-up information about a topic by clicking the 
right mouse button on an instruction or dialog box input name.  A “What’s This” 
information box displays information about the name or instruction. 

Shutting Down 
It is important to properly shut down Windows when turning off your computer—as 
opposed to just hitting the power switch.  Use the Shut Down command on the Start 
menu when rebooting or turning off your computer.  This allows Windows to save your 
work and make sure that no data is lost. 

The following steps should be taken when exiting a Windows session.   

1. Close any program you are running.  In most cases, use the Exit command from the 
File menu. 

2. Click the Start button and click Shut Down. 

3. Select from the list of options.  The number of options varies depending on whether 
you are connected to a network or not. 

4. Wait until you receive a message telling you it is “safe to turn off your computer.” 

 
The Shut Down Windows dialog box. 
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For More Information 
Here are some additional sources of information about the Windows operating system: 

• http://www.microsoft.com/windows - Microsoft’s Windows product page.  Find 
information on all versions of Windows. 

• http://search.support.microsoft.com - Microsoft’s main support page.  Use this page 
to search for information on specific topics related to Windows and other Microsoft 
products.  

Getting Additional Help 
Academic Computing Services provides consulting and Q&A help in a variety of ways: 

785/864-0200 
question@ku.edu 
www.ku.edu/acs/help 

To evaluate this course online, please visit www.ku.edu/acs/training/evaluation 

 

Last Update: 02/24/2003 

http://www.microsoft.com/windows
http://search.support.microsoft.com/
mailto:question@ku.edu
http://www.ku.edu/acs/help
http://www.ku.edu/acs/training/evaluation

	Introduction5Objectives5Prerequisites5Related Training Available from ACS5Definitions6Memory vs. Storage6An Orientation to the Desktop7Desktop7Icons7Folder icons7Application icons7Document icons8Original icons8Taskbar8Start button8Clock8Start menu8Organi
	Objectives
	Prerequisites
	Related Training Available from ACS
	Definitions
	Memory vs. Storage
	An Orientation to the Desktop
	Desktop
	Icons
	Folder icons
	Application icons
	Document icons
	Original icons

	Taskbar
	Start button
	Clock


	Start menu
	Organizing the desktop
	Adding items to the Program Menu
	Creating shortcuts

	Windows
	Parts of a window
	Title Bar
	Window buttons
	Minimize button
	Maximize button
	Restore button
	Close button
	The Menu bar
	Scroll Bars

	Resizing a window
	Moving a window
	Arranging all open windows

	Creating a new folder
	Moving or coping a file/folder
	Renaming files and folders
	Deleting a file/folder
	Searching for objects
	Using the Start menu to find a file/folder
	Using Explore to find a file/folder
	Advanced Searches
	Creating advanced searches
	Creating advanced searches based on date


	Application Basics
	Working with document files
	Opening a document
	Saving a document
	Saving a document with a different name or location
	Saving a document in a different file format


	Editing text
	Inserting text
	Deleting text
	Changing the size, font, or style of text

	Moving and copying document content
	Copying and pasting
	Drag and drop

	Undo

	Customizing Your Computer
	Control Panel icons
	Appearance and Themes
	Network and Internet Connections
	Add or Remove Programs
	Sound, Speech and Audio Devices
	Performance and Maintenance
	Printers and Other Hardware
	User Accounts
	Date and Time plus Language and Regional Options
	Accessibility Options


	Getting Help
	What’s This button

	Shutting Down
	For More Information
	Getting Additional Help

